
Creo Parametric 2.0 Tutorial 
 

Creo Parametric 1.0 Tutorial and MultiMedia DVD was written 
for Creo Parametric1.0. PTC released Creo Parametric 2.0 in 
the Spring of 2012.  This book is fully compatible with Creo 
Parametric 2.0 except for the changes shown in this insert. 

 
 
Chapter 1 
 
1-23 The Reorient command is located on the Named Views drop-down list. 
 

1-25  To turn model colors off, go to 
 

File > Options > Entity Display 
 

and turn off the check beside Show colors assigned to model surface. If you do 
this often, consider adding a command to the Quick Access toolbar at the top. 
 

Chapter 2 
 
2-10, 20, 22, 26, etc. “Yellow” arrows are actually magenta for the extrude directions. 
 

2-19 Sketcher open sketch endpoint dot is red instead of green; this happens on all 
sketches. 

 

2-23 In the Extrude dashboard, the Options group also contains a “Taper” option. 
 
Chapter 3 
 
No changes. 
 
Chapter 4 
 
4-19  The Measure drop-down command list, in addition to allowing you to directly 

launch one of the analysis commands (Length, Diameter, Area, Angle, etc.) 
opens a small window containing commands to quickly change to a different 
measurement. Also, the result is shown on a leader and result box on the screen. 
You can, for example, pick some entity on the model (an edge or surface, for 
example) and launch different measure tools referring to that entity. This is pretty 
easy to figure out, and of course there are shortcut commands on the RMB. 

 
Chapter 5 
 

5-10  In the Children Handling sequence, references are shown in red not green. 
 

 



Chapter 6 
 
6-13  Arrow showing direction of view onto sketch plane is magenta, not yellow. (Also 

occurs on page 6-17.) 
 

6-17  The Use Edge button in Sketcher has been renamed as Project. The button icon is 
the same. 

 
Chapter 7 
 
7-26 There is a typo on footnote 9. The Figure number should be 48. 
 
Chapter 8 
 
8-4  Format file creo_Aformat.frm contents updated. 
 

8-8   In the table, the driven dimensions should be addxx and oaddxx. 
 

8-19  The drag handles shown in Figure 20 are no longer used in Creo 2.0. You can 
select the dimension text and move it either along the dimension line, or 
perpendicular (in which case the dimension line moves with it). The witness lines 
can be selected one at a time (they will highlight in bold green), and one drag 
handle will appear beside the model. This can be used to move the witness line off 
the model. If additional cosmetic changes are required, select the dimension and 
in the RMB pop-up select Properties, then Move, Move Text, or Edit Attach 
commands may be used to modify the cosmetics. 

 
Chapter 9 
 
No changes. 
 
Chapter 10 
 
10-4   The footnote refers to a better way of creating sections. There is actually a new 

command on the Model ribbon for creating and managing sections. 
 

10-11   On the Intersect tab of the Extrude dashboard, the setting to adjust the display 
level is called Set Display Level, not Default Display Level. 

 

10-22  There is a whole new command sequence and options for creating sections, both 
in parts and assemblies. The Tutorial material on pages 22 through 23 is replaced 
with the material in the next section of this document. 

 
Chapter 11 
 
11-4   The arrow at the Start Point of the sweep is magenta (not yellow). 
 

11-11  The Blend command now uses the ribbon interface and is much easier to use. The 
Tutorial pages 11-21 are replaced by the material in the last section of this 
document. 



Chapter 10 – Sections 
 
For users with Creo 2: 
 
The next 3 pages replace the material on Sections on pages 10-22 to 10-23 in 
the book.  
 
When finished, return to the book and continue with “Assembly Modeling” 
on page 10-23. 
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Sections

Cross-sections, or just sections, are very common in assembly drawings (which we will
get to next). Although sections can be created in drawing mode (as we did with the pulley
in Lesson #8), it is often handy to have them available when you are working in assembly
mode. This can allow you to check for fit and/or interference between components,
measure clearances, and just generally help understand how an assembly fits together.
Sections are very easy to create. You can define multiple sections in the same model, of
different types and at different locations, and display as many of them at the same time as
you like.

Remind yourself of the orientation of the default assembly coordinate
system - that will be relevant for what follows. Set your display as
follows: shading on, colors off, datums off. 

We are going to recreate the view of the assembly obtained with the
assembly cut earlier in this lesson. When using a extruded cut to do
this, our only options are to suppress or resume the cut and to
determine which components were intersected by the cut. The
Section command allows us to do a lot more, and much more easily.
The section functionality in Creo works with parts as well as with
assemblies.

Go to the Model ribbon. In the Model Display group, click on the Section pull-down
menu. This is shown in Figure Creo 2-1. The Planar, X, Y and Z Direction commands will
create planar sections, with the first being the most general. The Offset option allows you
to create a section using a sketched curve to define the 2D shape of the cutting plane.

Select the ZDirection command. The model appears 
as in Figure Creo 2-2 and the Section dashboard
opens as shown in Figure Creo 2-3.  This creates a 
view of the model with a cutting (or clipping)  
plane whose normal is the Z axis direction of the 
assembly default system. This is the same view we 
created earlier using the cutting plane. An offset 
value is given that can be changed by dragging 
on the arrow normal to the section surface 
or double clicking on the numeric value. 
Try that now, setting the offset to 20.

Let’s have a look at the dashboard - feel free to try
these commands out as we go. Starting at the left,
the orientation of the section normal is given in a
drop-down list. The next box shows the offset distance from the chosen coordinate
system (shown in the References tab below). The Flip button allows you to select which
side of the section plane is removed. The Capping Surface button (on by default) toggles
the surface created on the section plane. If the surfaces are capped, the next button lets
you toggle on/off and set their color. The Hatch button does just that - toggles the

Figure Creo 2-1 
The Section 
pull-down menu

Figure Creo 2-2 Section defined 
(Z direction, offset 20)
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presence of a hatch pattern on each component. Notice that the hatch on each component
is different. We will see later how these hatch patterns can be changed. Next is the
Dragger for free positioning of the clipping plane. Select that now. Dragging on the
arrows or rings allows us to change the position and orientation of the clipping plane. See
Figure Creo 2-4. The Dragger is turned on automatically if you select Planar to launch the
Section command. If you turn off the dragger, the clipping plane returns to the originally
selected (Z, in this case) direction. Finally, the 2D View button opens a new window to
show the section plane in true shape (looking normal to the section). Select the 2D View
button in the dashboard again to close this window.

Let’s explore some of the section options in the dashboard tabs. The References tab lets
you set the coordinate system used to determine the section normal direction. You can
also pick on any plane surface in the model to specify the location and orientation of the
section plane. The Models tab allows you to select which components to include or
exclude from the section. Select the Exclude option and pick (with CTRL) the base plate
and the axle. This components are now not clipped (Figure Creo 2-5). Note the option for
selecting whether the section is defined for the assembly or a part. The next tab, Options,
lets you toggle the visibility of interfering components. You can set the color of the
interfering volume. Finally, the Properties tab lets you specify the name for the section,

Figure Creo 2-3 The Section dashboard

Figure Creo 2-4 An oblique clipping 
planecreated using the 3D dragger

Figure Creo 2-5 Base plate and axle
componenets Excluded from section
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as it would appear on a drawing. Type in “A” for the name of this section.

Change the offset back to 0, with our initial Z direction section. After setting all the
section options, a middle click with accept the section definition. It will disappear from
the model in the graphics window. However, it is now listed at the bottom of the model
tree. Clicking on the section entry will show the outline of the sectioned parts.  If you use
the RMB pop-up menu, you can select Activate to make the section visible. With the
section selected and activated, the RMB menu also allows you to execute most of the
commands in the section dashboard.

Select the bushing component in one of the
subassemblies, then open it using the RMB menu.
Change the outer diameter to 35 and Regenerate.
Return to the assembly window and Activate the
section. Use the RMB and select Edit Definition.
You should see a red highlight of the interference
between the bushing and the L-bracket as shown in
Figure Creo 2-6. If not, in the Options tab, check 
the box to show the interference. 

Note that in the RMB pop-up for sections you have
options to pattern the section, flipping the clip
direction, edit the hatch patterns and offset
distance. You can also Rename, Suppress, or
Delete the section. The Show Section toggle option controls the visibility of the hatch
patterns.

Another way to deal with sections is with the View Manager. Open this window and
select the Sections tab. You will see the section “A” we created previously. You can use
the Edit and Option pull-down menus (and RMB pop-up) to access a number of
commands for activating, editing hatch patterns, and so on. You cannot change the
position or orientation of the section. Using View Manager, you can use defined sections
as part of the display style.

Use the RMB pop-up to Deactivate the section. Don’t forget to Save the assembly.

Figure Creo 2-6 Interference of bushing
outer diameter and hole in L-bracket

Continue with "Assembly Modeling" on page 10-23.



Chapter 11 – Blends 
 
For users with Creo 2: 
 
The next 9 pages replace the material on Blends on pages 11-12 to 11-21 in 
the book.  
 
When finished, return to the book and continue with “Conclusion” on page 
11-22. 
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1 For some variations of the Blend command you must set the configuration
option enable_obsoleted_features to yes. These commands (eg. Project Section Blend)
will then appear on the Commands Not in the Ribbon list. For further information, see
the on-line help.

2  Note that this does not mean flat surfaces. A ruled surface is one where from
every point along the curve defining one section there exists a straight line or edge to a
matching point on the adjacent section.

Blends

A blend is like an extrusion with a changing cross section. Some systems call these
“lofts.”  The different cross sections are specified using a number of sketches or edge
chains. These can be created either inside or outside the blend feature. The distance
between cross sections is then specified either with references or explicit dimensions.
The dimensions can be either a linear distance (forming a parallel blend) or an angular
distance (forming a rotational blend), or a combination of these (a general blend). You
can maybe imagine what a swept blend would involve. In the following, we will look at
the first two of these. A blend can be used to create a protrusion or a cut. Some
restrictions apply1:
 

‚ At least two sections are required.
‚ Sections can be either selected from existing sketched curves, or created

from chains of edges.
‚ Each section must have the same number of vertices; normally this means

the same number of line (or arc) segments.  This rule can be overridden
using a blend vertex (see the on-line help for information on this).

‚ Each section has a starting point (one vertex on the sketch) - these must be
defined to align all the sections properly or else the resulting geometry
will be twisted.

‚ Parallel blends can use projected sections (obtained by projecting existing
sketches or curves onto different planes).

‚ For a rotational blend, the section planes can be no more than 120 degrees
apart.

‚ For a rotational blend, the axis of rotation is common to all sections, and
all section planes must intersect the axis.

The sections of the blend can be connected either with straight (ie. ruled) surfaces (see
Figure 25)2, or with smooth surfaces (Figure 26).
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Figure 25 A Straight parallel blend Figure 26 A Smooth parallel blend

Parallel Blend

This is the simplest form of a blend. We will create the part shown in Figures 25 and 26.
This blend has three sections as seen in Figure 31 created using separate sketched curves
on three permanent datum planes, but make datums would do just as well. This
construction method has the advantage of making it easier to visualize the final blend
shape.

Start up a new part called blend1 using the default template.

Create a couple of datum planes using the
Plane tool. For the first, click on the FRONT
datum. The default is an Offset datum, so just
enter a value of 400. Select OK or middle click.

With DTM1 the active feature (green
highlight), you can create DTM2 with two
mouse clicks:

Plane 

then middle click (since Offset and 400 are
defaults).

Now create our three sketched curves that will define the blend sections. Select  Sketch
and pick FRONT as the sketching plane. The default RIGHT reference is fine. The first
sketch is shown in Figure 28. The sketch is symmetrical about RIGHT and the lower
edge is along TOP. Notice that the sketch has four vertices. This is important, since each
section in the blend must have the same number of vertices.

Figure 27 Datum planes to define
section sketches
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Figure 28 First sketch for blend (on
FRONT)

Figure 29 Second sketch for blend (on
DTM1)

Figure 30 Third sketch for
blend (on DTM2)

Figure 31 Three curves to define
blend sections

The second sketch (Figure 29) is created on the second datum plane DTM1. It is also
symmetric about RIGHT, and contains four vertices. Note the lower edge is on TOP.

Finally, create the third section sketch on DTM2. This sketch is shown in Figure 30.
Again, it has only four vertices.  When complete, your model should look like Figure 31.

Now we can launch the Blend command. In the Model ribbon, Shapes group drop-down,
select

Blend

This opens the Blend dashboard. The four buttons on the dashboard are (starting from the
left):

Solid Blend
Surface Blend
Blend with Sketched Sections - which means you create the sections using

sketches inside the blend feature, and
Blend with Selected Sections - use previously created sketches to define

the sections
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Select the fourth button now. Pick on the
sketched curve on the FRONT datum. It
will highlight in bold green and a small
white dot with a magenta arrow will appear
on one of the vertices. This is the Start
Point of the section. It is important that the
start points of each section are chosen
correctly, as we will see in a moment. Click
on the start point and drag it to the top left
vertex, as shown in Figure 32. We want the
direction arrows on each section to go
around the sketch in the same direction - in
this case clockwise. If it is pointing the
other way, just click on it (or use the RMB menu and select Flip Arrow Direction).

With the mouse in the graphics window,
open the RMB pop-up menu and select
Insert. Now click on the next sketch (on
DTM1). It will highlight in bold green, and
the blend between the two sections will
preview. Once again, a white dot will
appear on one of the vertices of the sketch.
We need the start point to again be on the
top left vertex in the section, as shown in
Figure 33, to align the sequence of vertices
in the second section with those in the first.
If the vertex is not at the proper vertex, the
blend will be warped - just drag the white dot to the desired vertex, and click on the
magenta arrow to make sure the sequence direction is correct.

Once again open the RMB pop-up menu and select Insert. Click on the third sketch (on
DTM2). The sketch highlights in green. As before, if the start point is not on the right
vertex we will get a twisted shape (Figure 34). If so, drag the start point to the correct
vertex, as in Figure 35.

Figure 32 Blend section #1 selected. Note
the position of the Start Point.

Figure 33 Blend section #2 selected

Figure 34 A warped section caused by
misplaced start point

Figure 35 Blend section #3 with correct
start point selected
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3 Move the insert point before the blend, and create two extrudes using the first
and third sketches (extrude from sketch #1 going back, sketch #2 coming forward).
Resume the blend and experiment with the tangency option to the extrudes coming off
each end of the blend.

If you accept the feature with a middle click, the blend will appear as in Figure 26 above.
In the model tree, note the icon used for a blend feature. Select the feature and in the
RMB select Edit Definition. As usual, this brings us back to the feature dashboard.

Open the Sections tab in the dashboard. This lists the three sections (which highlight on
the model if you select one in the list) and the number of vertices in each section. In the
Options tab, you can select between a Smooth blend, or a Straight blend (Figure 25). The
Tangency tab gives access to controls for how the blend will merge with adjacent
geometry at each end of the blend3. Finally, the Properties tab is to specify a non-default
name for the feature.

You might like to try to Edit the dimensions of the blend. These are driven by the three
sketched curves and the datum planes. Selecting these and using the Edit command in the
RMB pop-up will let you change blend dimensions. Or, double click on the blend (??)

The Shell Command

Just for fun, here is a feature creation command we haven’t mentioned before. Pre-select
the blend feature (edges highlighted in green) and in the Model ribbon, pick the Shell
tool  . This defaults to hollowing out the highlighted object (shelling it) using a
default thickness for the remaining shell wall (see the dashboard). A flip button allows
you to create the shell on the inside or outside of the existing model surfaces.

In addition to shelling the model, we want to remove the two end surfaces. Open the
References slide-up panel. This contains two panes. Click in the Removed Surfaces
pane and pick on the front and back surfaces (using CTRL) as shown in Figure 36. These
will highlight in green as they are picked. The interior faces are shown in preview
orange.  Change the shell thickness to 10. The other pane in the References panel allows
us to set different thicknesses for different regions of the shell. Accept the shell feature.
The part looks like Figure 37. Open the model tree and observe the icon used to indicate
the shell.
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Figure 36 Surfaces to be removed
during Shell creation

Figure 37 The Shelled part

The Shell command can handle quite complicated geometry, but is not foolproof. You
may find that the command will fail sometimes if the geometry is too complicated
(typically if a shelled surface has to pass through itself). Normally, the shell command is
used fairly early in the model before this situation can develop.

Let’s move on to our last new feature in this lesson. Save the current part (for later
experimentation) and remove it from session.
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Figure 38 Two rotational blends: smooth (left), and straight (right)

Figure 39 Completed section
sketches for rotational blend

Rotational Blend

A rotational blend is set up by specifying the cross sections on a number of sketching
planes that have been rotated around a common axis - thus the sections are not parallel.
We are going to make the part shown in Figure 38. Rotational blends can create either
protrusions or cuts, and can be either solid or surface features.  The usual restrictions
apply as to the number of vertices in each section and the start point defined on each
section. For some rotational blends, consecutive sections can be no more than 120
degrees apart. The spacing between consecutive sections does not have to be the same.
Sections can either be selected from existing sketches (as we will do here), or sketched
internally in the feature.

Start a new part called blend2 using the default template.
You can delete the default coordinate system. It will be
handy to turn on the display of the datum plane and axis
tags.

We are going to create the four rectangular sketches
shown at the right. The first sketch will be on FRONT.
The next three will be on datum planes created using angle
offsets to the previous sketch plane. These datum planes
share a common axis.

Create the axis A_1 by selecting (with CTRL) the RIGHT
and FRONT datum planes, then the Axis tool in the
Datum group.

Create DTM1 by selecting the axis A_1 and FRONT, then Plane. Set an offset of 30.
This will be counterclockwise looking down from the top - you may have to enter -30 to
get the angle you want, with the positive side of the new datum facing more-or-less to the
front.

Create DTM2 by selecting the axis A_1 and DTM1, again with an offset of 30.  Finally,
create DTM3 by selecting the axis A_1 and DTM2, with an offset of 30. This will line up
with the RIGHT datum, which you might as well Hide now to avoid confusion.
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Figure 40 Section 1 on FRONT Figure 41 Section 2 on DTM1

Figure 42 Section 3 on DTM2 Figure 43 Section 4 on DTM3

Figure 44 First section selected

We have set up the section planes this way so that we can easily adjust the angle between
successive sections. If you use a parameter and some relations, you can set these all
equal, or make them some function of other geometry in the part.

Create the four sketched curves shown in Figures 40 through 43 on the datum planes
indicated. In each sketch, the horizontal reference is TOP, and the second sketching
reference is the axis A_1. If the screen gets a little cluttered after the first couple of
sketches, go ahead and hide them. You can imagine that using references to existing
geometry in the new section sketches could complicate matters here if we want to make a
very robust feature.

Launch the Rotational Blend command in the
Shapes group overflow menu. The dashboard
opens, looking very similar to the dashboard
for the parallel blend we did earlier. There is
one new button for specifying the rotation axis.
Pick the button for Selected Sections (fourth
from left). 

Select the first sketch (on FRONT). Observe
the start point, and drag it to the top left corner
if necessary, as shown in Figure 44.

Now open the RMB pop-up menu and select
Insert. Pick on the second sketch. The sketch will highlight and the blend will preview as
in Figure 45. If the start point is on the wrong vertex, the blend will be twisted.
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4 This may not work for all possible blends. For example, in this case the ends
cannot be connected if you select a Straight blend.

Figure 45 Second section selected Figure 46 Final section selected

Figure 47 Sections at 140E offset

Continue using the RMB pop-up menu and Insert to select the third and fourth blend
sections, making sure the start points all line up. The final previewed feature is shown in
Figure 46.

Notice that the rotation blend axis was chosen automatically in this case. For some
options of the command you must select that yourself, in which case you can use any axis
or straight edge. Of course, you only do this once, since the same axis is used for all
sections. If you open the Sections tab, you will see the same options we saw before
(radio buttons for Sketched or Selected sections, listed sections, number of vertices,
etc.). In the Options tab, you can select either Smooth or Straight blends. There is an
additional option here for connecting the end and start sections of the rotational blend4.
This creates a closed feature. The Tangency options operate the same as the parallel
blend (note that these are available with the RMB pop-up menu when the large white
circles are selected at the start and end sections), and the Properties tab allows you to
specify a name for the feature.

Accept the feature and close the dashboard.
Experiment with the dimensions of the feature (the
datum plane offsets, sketch dimensions, etc.). The
variety of geometry you can create is quite
remarkable, as shown in Figure 47.

That completes our limited presentation of blends.
As you can see, blends contain a lot of geometric
information and are therefore a bit more difficult to
set up. However, they offer considerable flexibility
and can create very complex shapes not attainable
with the simpler features. There are advanced
features (swept blends and helical blends, for example) that offer even more
complexity/flexibility. Consult the on-line help for information about these.
 
 
                             Continue with "Conclusion" on page 11-22. 
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